
Contacting HiSoftware
Getting Support

Hi-Stats support is provided free of charge via e-mail or on our web site via FAQS and 
helpful hints.

World Wide Web:
To access support via the World Wide Web please visit 
http://www.hisoftware.com/support/index.html

Support Contacts:
E-Mail:Support@hisoftware.com
Web: http://www.hisoftware.com/
Fax: 603.223.9741
Regular Mail:
Hiawatha Island Software
6 Chenell Drive
Concord, NH    03301

Visit http://www.hisoftware.com/ for information on ordering this product:
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Copyright
HiSoftware
Hiawatha Island Software Company, Inc.
6 Chenell Drive
Concord, NH 03301
USA

Hi-Stats(tm)

No part of this publication or software may be reproduced, transmitted, transcribed, stored 
in a retrieval system, or translated into any other language or computer language in whole 
or in part, in any form or by any means, whether it be electronic, mechanical, magnetic, 
optical, manual or otherwise, without prior written consent of Hiawatha Island Software 
Company, Inc.



Documentation
Printed documentation for all HiSoftware products is available in the HiSoftware web site at 
http://www.hisoftware.com/doccentral/doccentral.htm.    Documentation is available in 
Microsoft Word format or Adobe Acrobat format.



Download Errors

The Download Errors Analysis report tabulates the number of errors that occurred when 
trying to download a file during the given time frame. 
This information can be used to determine if web users are trying to download files that are 
missing from the web site.    It can also be used to alert you of web guests trying to 
download files they are not authorized to download such as web system files and such.



Errors Occurring Most Often

The Errors Analysis Total report tabulates the total number of errors that occurred during 
the given time frame.      See your web server documentation for more information on these 
errors.

Some common errors are:
· 400:    Bad Request:    The request could not be understood by the web server due to bad 

syntax.
· 401:    Unauthorized Request:    This error typically occurs when the web server will not 

allow that request to be completed due to security settings related to a user name and 
password.

· 403:    Access is forbidden:    The web server will not allow that HTTP request to be 
completed due to security settings.    For example, the web server may not allow access 
for a specific set of IP addresses.    If a user from one of those IP addresses accesses the 
web page, that error will appear.

· 404:    Object not found:    Typically, this error occurs when the requested web page could 
not be found on the server.

· 405:    Method not allowed:    This error may occur if a there is a configuration problem 
between the web browser client and the web server.

· 500:    Server Error:    This error typically occurs when the web server encounters an 
unexpected condition.

· 501:    Not Implemented:    The web server is not configured to handle that sort of HTTP 
request.



Hi-Stats

Hi-Stats provides web site analysis based on the log files provided by the web site’s server 
program.    Hi-Stats requires access to the web server log files, but does not require access 
to the actual web server, allowing many more users the ability to analyze web site traffic.

Table of Contents

Features of the program include:
· Standard User Interface:  Using the Hi-Stats interface you can quickly create web site 

trend analysis reports. This standard interface is based on our award winning interfaces 
of Hi-Verify and TagGen. 

· No Server Access Required: Hi-Stats Log Analysis Solution does not require direct 
access to your web server, it is installed on a local client and can be run from log files 
stored locally that are retrieved from your server. 

· Supports all common log file formats:    The Hi-Stats Log Analysis Solution processes 
all industry standard Web server log files.      Microsoft IIS and Site Server, Netscape, 
Apache, CERN, NCSA, and more.

· Clear and Detailed reports:    Reports generated by the Hi-Stats Log Analysis Solution 
present data in clear easy to read tables (like a spreadsheet). 

· Review visitor behavior 

· Search Engine Referrers 

· Search Engine Crawler Visits 

· Usage Analysis by day or hour 

· Visitor Habits 

· Page Errors 

· Unique Visits 

· Hits 

· and much more 

· The reports are delivered in Industry Standard HTML. Easily read and navigated. 
Reports can be e-mailed or saved to disk.

· Virtual Log File Database:    The log files are imported into a "Web" (a collection of log 
files) they are made to evaluate quicker to allow for fast runs; a 100,000 line log file will 
process all of the reports in a little over a minute. (That is for complete reporting)

Differences in the versions

Hi-Stats Basic supports up to 3 webs.
Hi-Stats Professional supports up to 50 webs.
Hi-Stats Enterprise supports unlimited webs.
Hi-Stats Small Business Server supports importing the logs to a shared directory for 

use by Client versions.
Hi-Stats Small Business Server Client cannot import webs, but can create reports 



from imported webs created by the Server edition.



Most Popular Downloads

The File Download Analysis report lists the most popular downloads on your site, based on 
the number of times downloaded in the given time frame. It lists the download file name, 
number of downloads and the percentage of downloads as compared to the total. Results 
are ordered from most downloaded to least.

By determining which files are downloaded the most, you can further tailor your marketing 
strategy towards certain product lines and such.    If the number of downloads for files 
restricted to paying customers are increasing far above the number of sales, it could be a 
sign of software piracy.



Most Popular Pages

The Page View Analysis report lists the most popular pages on your site, based on the 
number of hits each has received in the given time frame. It lists the page name, number of 
hits and the percentages of hits as compared to the total number of hits. Results are 
ordered from most hits to least hits.

Knowing which pages have the most hits, you can determine where to place content, what 
page designs work best and what pages may be linked to from external sites.



Page View Errors

The Page Errors Analysis report tabulates the number of errors that occurred when trying to 
view a page during the given time frame.    Each page is listed along with the error relating 
to that page, the number of occurrences and the percentage of total errors for that 
particular error.
This information can be used to determine which pages web guests are requesting that are 
not being displayed to them.    This could mean that the page has a problem or is missing 
altogether.



Profile Editor 

The Profile Editor is used to create report profiles that are used to create the analysis 
reports.

Creating a new report profile with the profile editor

1. From the Hi-Stats main window, select the New button on the toolbar.    The Profile 
Editor opens.

2. Enter a name for the report in the Profile Name field.

3. Enter the URL of the Internet web site in the URL field.

4. Enter the name of the administrator for the Internet web site in the Profile 
administrator field.    Enter the e-mail address of this individual in the address below.    
The e-mail address should be formatted as someone@some_company.com

5. If you are creating the web site analysis for a client, you can enter the e-mail address of 
the client in the Customer E-mail Address field.    The two e-mail and Profile 
Administrator fields are optional, while the Profile Name and URL are not.

6. When done with this tab, go to the Select Web tab.

7. Choose a Hi-Stats web from the menu in this page.    If you have not yet created a web, 
close the Profile Editor and create a web using the Web Management option from the 
File menu and consult the help for Web Management.    Note:    Users of Hi-Stats Small 
Businesss Server Client cannot create webs, but can use webs created by Hi-Stats Small 
Businesss Server.

8. When complete with the Select Web tab, move to the Time Period tab.

9. The Time Period tab is where you select the time period for the web analysis reports.    
You can select from the listing of Predefined ranges or you can select the Run the 
report for the specified date range option and then select the range in the data 
range below.    It is important to make sure that the time period you select corresponds 
to the log files that you have.    For example, if you have log files for March and April, but 
you select a time period in February, then Hi-Stats will not have all the information it 
needs to run the report. 

10. When you have selected a date range, proceed to the Report Information tab.

11. The top section of the Report information tab lists the four major report categories 
(Page, Browser, Usage and Referral).    The recommended options are to choose all four, 
but if your web log files do not contain Browser and Referral analysis, then you can 
choose not to select to view reports for them, since there will be no data.

12. If you wish to view graphs for the reports, you can select the checkbox to Generate 
Graphs for Reports.    You have the option to generate 2D or 3D graphs.

13. When the report is complete, you can select that the output be directed to the default 
web browser, and additionally e-mailed to the customer and administrator as outlined in 
the Profile Identification tab.    Select the checkboxes beside each one of these options to 
enable it.

14. In addition to the report output to the browser, you can also create reports in a CSV 
(comma separated value) format.    These reports can then be opened by a spreadsheet 



program for your use there.    To create reports in CSV format, select the Create CSV 
files checkbox.    If you want to automatically overwrite any other CSV files, that may 
exist, select the Automatically overwrite CSV files if they exist checkbox.    Use the 
file chooser control to select a path to copy the CSV files to.

15. When you have completed this tab, continue to the Filters tab.

16. You can also exclude IP addresses from your report.    If you wish to exclude IP address 
from your report, please see the Exclude IP Address help.

17. You can also generate sub domains for your web.    You can select to only include a 
certain sub domain or folder, or to exclude several folders from the report.    Please see 
help for sub domains.

18. When you have completed the Filters tab, move to the Special tab.

19. In the Special tab, you can add advertising and affiliate domains.    By adding affiliate 
and advertising domains, the reports can show when web guests are referred to by 
advertising and affiliates.

20. When you have completed adding information into the Profile Editor, select the Save 
and Close button.

Common Toolbar
· Set Defaults:    Selecting the Set Defaults button saves all settings in the Profile Editor 

as default.
· Close:    Selecting the Close button closes the Profile Editor
· Save and Close:  Selecting the Save and Close button saves all changes and closes the 

Profile Editor window.
· Help:    Selecting the Help button opens the help for the Profile Editor

Profile Identification
· Profile Name:  Enter the name of the profile in this field.
· URL: Enter the URL of the web site for the analysis.    For example, 

http://www.hisoftware.com
· Profile Administrator:    Enter the name of the individual responsible for administering 

the profiles.
· Administrator E-Mail:    Enter the E-Mail of the individual responsible the 

administration of the report.
· Customer E-Mail address:  Enter the E-Mail of the customer for whom this analysis 

will be performed.

Select Web
Select a Hi-Stats web for this profile from the listing of webs.    If you do not have a web, 
select Web Management from the File menu to create a web.    Please refer to the help topic 
for web management.

Time Period
· Predefined Ranges:  Select a predefined range for the report.    Many predefined 



choices are available.
· Use Date Range:    You can select a custom date range.    For example, if you were 

running a banner advertising campaign for 10 days, you could select the beginning and 
end of the campaign using these custom dates.    To use, select a valid date range using 
the calendar control that appears once the menu has been selected.

Report Information - Information Requested
Hi-Stats allows you to select four categories to include in the report.    The program includes 
all four by default, but the user can unselect the checkboxes beside the categories to 
remove them from the report.    The categories are:
· Page Analysis
· Browser Analysis
· Usage Analysis
· Referral Analysis

See the help topic for reports for more information on these analysis reports.

Report Information - Demographic Analysis
If your log files support a reverse domain name service (DNS) lookup, Hi-Stats can provide 
six additional reports for use in determining what country, domain and machine your hits 
and sessions are originating from.    In order to get full benefit from these reports, your web 
server must perform a reverse DNS lookup for entries into the web server log file.    It then 
replaces the client IP address with the domain host name if possible.    Please see your web 
server documentation or your Internet Service Provider for more info on modifying the web 
server log file.

Report Information - Output Settings
· Report Title:    Enter a title for your report in the Report Title field.

Report Information - Send output to
The program allows the output to be e-mailed, output to the default web browser or both.    
The options are:
· E-mail Administrator:    Sends an e-mail with the report to the address listed in the 

Administrator field in the Profile Identification tab of the Profile Editor settings.
· E-mail to customer:    Sends an e-mail with the report to the address listed in the 

Customer field in the Profile Identification tab of the Profile Editor settings.
· Output to browser:    This option outputs the report to the system’s default web 

browser program.
Select the checkbox beside each to enable that feature

Report Information - Create Report Files
Hi-Stats™ allows for the creation of a report file in CSV (comma separated value) format.    
This report could then be imported into programs that support CSV files such as 
spreadsheets.
· To create a CSV file, select the Create CSV file checkbox.
· To automatically overwrite previous reports if they exist, select the Automatically 



overwrite files if they exist checkbox.
· Use the Select Folder button at the bottom right of the Report Information screen to 

select a path for the folder.

Options Tab

Hit Filter Options:
Pages:    Selecting the Pages checkbox instructs Hi-Stats to include web pages such 

as HTM, HTML, ASP and similar type pages in the reports.
Download Files:    Selecting the Download Files checkbox instructs Hi-Stats to 

include the types of files typically downloaded from a web into the report.    These file types 
include EXE, PDF, Zip and other files.

Images:    Selecting the Images checkbox instructs Hi-Stats to include web image 
files in the report.    Image files include JPEG, GIF, BMP and other image types.

Other:    Selecting the Other checkbox instructs Hi-Stats to include the types of 
requests not listed in the types above.    This includes any type of script file that web clients 
may need to download when visiting certain webs, or certain types of CGI requests.

Referring URL, Browser, User OS Rules
When tracking the Referring URLs, the Browser Types and the User Operating Systems, you 
have the option to either track those requests by pages and files or track by unique 
sessions.

Select Track by Pages and Files to display results based on a reporting of all user 
requests.    For example, if a web guest had five hits on the same file, the hits would count 
each time the web guest accessed the file.    Note:    This option does not include images in 
its results.

Select Track by Unique Sessions to display results based on a reporting on unique 
sessions.    For example, if a web guest had five hits on the same file, the hits would count 
only once.

Using Sub Webs
Hi-Stats™ allows you to filter sub webs and subdirectories of your web. 
1. In the Filter tab of the Hi-Stats Profile Editor, select the Add button underneath the 

Automatically Generate Sub Domains view.    The Web Filter window appears. 
2. Enter a directory name in the Dir Name field for the directory that you want to include. 

This could be a standard directory or a virtual directory.
3. Select the Set to Sub Web option and click OK.
4. If you want to exclude the subdirectories under your included sub web, enter the 

directory name and select the Exclude Directory button in the Web Filter window and 
click OK.

5. Select the Save button when done.

Filters
Hi-Stats™ allows you to filter IP addresses, excluding them from the report.    This is useful 
if you do not want to see data gathered on your web site from visitors such as those in your 
own company or organization, since these visitors may skew the results of your analysis.



To exclude IP addresses:
1. Select the Filters tab of the Profile Editor, and then select the Add button in the 

Exclude IP Addresses field.
2. To exclude one IP address, enter the IP address in the field and select the Exclude 

Single IP Address option.
3. To exclude multiple IP Addresses, enter the beginning IP address in a sequence into 

the IP address field.    Select the Exclude IP address Range option and enter the 
ending IP address in the Exclude IP Address Range field.

4. For example, if you want to exclude IP addresses 192.168.0.4 through 192.168.0.55, 
you would enter 192.168.0.4 in the IP Address field and 192.168.0.55 in the 
Exclude IP Address Range field.

5. Select the OK button when done.

To exclude Referring URL/Domains from report
1. Select the Filters tab of the Profile Editor, and then select the Add button in the 

Exclude Referring URL/Domains field.
2. Enter the domain that you wish to exclude.    If, for example, you wanted to exclude 

the www.hisoftware.com domain, you would enter www.hisoftware.com and then 
select the Ok button.      You can also enter an IP address such as 172.16.0.1 or 
172.16.0.9:3323 instead of a domain so as to exclude certain IP addresses.

For help on sub-domains, select this topic.

Special 

The Special tab is used enter the IP addresses of Advertising and Affiliate domains.    
These domains are then used in the analysis reports.

To enter an advertising domain, select the Add button in the left side of the Special tab.    
Enter the domain name in the window and click OK.

To enter an affiliate domain, select the Add button in the right side of the Special tab.    
Enter the domain name in the window and click OK.



Referring Advertising Domains

The Referring Advertising Domain Report tabulates the referrals from domains you have 
designated as Advertising Domains pointing to your site. Results are ordered by number of 
referrals they made.



Referring Affiliate Domains

The Referring Affiliate Domain Report tabulates the referrals from domains you have 
designated as Affiliate Domains pointing to your site. Results are ordered by number of 
referrals they made.



Top Browser Types

The Browser Agent Analysis report lists the selected number of web browsers used to access 
your site based on the number of requests made by the browser type in the given time 
frame. It lists the Browser Type, number of hits and the percentages of hits as compared to 
the total number of hits. Results are ordered from most common to least common. 

You can use this information to help develop the content of your web.    If you want to use 
advanced features in web site, but determine that only 20 percent of all visitors will be able 
to support these features, then you may not want to spend the time to do this.    If you have 
many visitors with older browsers, you may want to make sure that your web site meets 
their needs as well.



Top Referring Domains

The Referring Advertising Domain Report tabulates the referrals from domains you have 
designated as Advertising Domains pointing to your site. Results are ordered by number of 
referrals they made.



Top Referring Search Engine Keyword Phrases

The Referring Search Engine Keyword Phrase Report tabulates what keyword phrases have 
been used on the popular search engines to locate the Web site, for the selected time 
period.    This is useful because you can determine which keywords are directing users to 
your site on the engines.



Top Referring Search Engine Keywords

The Referring Search Engine Keyword Report tabulates what keywords have been used on 
the popular search engines to locate the Web site, for the selected time period.    This is 
useful because you can determine which keywords are directing users to your site on the 
engines.



Top Referring Search Engines

The Referring Search Engine Report tabulates Search Engine pointing to your site ordered 
by number of referrals they made.    At the bottom of the list is a percentage of total search 
engine referrals versus total referrals.



Top Referring URLS

The Referring URL report tabulates all URLs pointing to your site ordered by number of 
referrals they made.    The URLs are listed in order of number of referrals.    The table shows 
the actual number of referrals along with the number of referrals and their percentage.



Usage by Hits

Usage by Hits reports the number of requests made in the given time frame. A Hit is 
considered any request for data such as a web page, image, or file.    For example, if you 
have a web page that had two images, ran one script and played one wave file, there would 
be five hits for that web page.    The report shows the hour, the number of hits for that hour 
and the percentage of hits for that hour.



Usage by Kilobytes

Usage by Kilobytes reports the number of kilobytes sent in the given time frame. The total 
movement of pages, images, files and CGI requests are counted.
This is important because it helps you keep track of the bandwidth used by the web server. 
Some Internet Service Providers determine monthly fees based on bandwidth.    You may 
also wish to know the bandwidth so you may plan for scheduled service upgrades as 
bandwidth increases.



Usage by Session

Usage by Sessions reports the number of sessions started by hour in the given time frame. 
Sessions are tracked per unique IP address.

With this information, you can track individual guests to your web site.    This can be used to 
determine the number of individual users to the web site over specified time periods.      The 
report outlines the number of sessions started per hour and their percentage of total 
sessions.



User Agent Operating Systems

The User Agent Operating System Analysis Report lists the User Agent Operating Systems 
used to access your site ordered from most common to least common. 

This information can be valuable in determining the audience of your web site.    Knowing 
the audience, you can tailor your content or advertising to specific users.    If you had a 
large number of LINUX users on your site, you may offer content that specifically targets 
these users.



Using Filters

IP Filters
Hi-Stats™ allows you to filter IP addresses, excluding them from the report.    This is useful 
if you do not want to see data gathered on your web site from visitors such as those in your 
own company or organization, since these visitors may skew the results of your analysis.

To exclude IP addresses:
1. Select the Filters tab of the Profile Editor.
2. Select the Add button.
3. To exclude one IP address, enter the IP address in the field and select the Exclude 

Single IP Address option.
4. To exclude multiple IP Addresses, enter the beginning IP address in a sequence into 

the IP address field.    Select the Exclude IP address Range option and enter the 
ending IP address in the Exclude IP Address Range field.

5. For example, if you want to exclude IP addresses 192.168.0.4 through 192.168.0.55, 
you would enter 192.168.0.4 in the IP Address field and 192.168.0.55 in the Exclude 
IP Address Range field.

6. Select the OK button when done.    Don't forget to save if this is your last tab you are 
editing in the profile.

To exclude Referring URL/Domains from report
1. Select the Filters tab of the Profile Editor, and then select the Add button in the 

Exclude Referring URL/Domains field.
2. Enter the domain that you wish to exclude.    If, for example, you wanted to exclude the 

www.hisoftware.com domain, you would enter www.hisoftware.com and then select 
the Ok button.    You can also enter an IP address such as 172.16.0.1 or 
172.16.0.9:3323 instead of a domain so as to exclude certain IP addresses.



Using Sub Domains

Hi-Stats™ allows you to filter sub webs and subdirectories of your web. 
1. In the Filter tab of the Hi-Stats Profile Editor, select the Add button underneath the 

Automatically Generate Sub Domains view.    The Web Filter window appears. 
2. Enter a directory name in the Dir Name field for the directory that you want to include. 

This could be a standard directory or a virtual directory.
3. Select the Set to Subweb option and click OK.
4. If you want to exclude the subdirectories under your included sub web, enter the 

directory name and select the Exclude Directory button in the Web Filter window and 
click OK.

5. Select the Save button when done.



Using the Reports

Hi-Stats provides HTML based reports.    After an analysis has been run, Hi-Stats™ opens 
the Windows default web browser to the Web Server Log Analysis Report Index.    From 
here, a list of categories appears in a table.    Select a particular report and double click on 
the name to open a new page where the results of that report are displayed.

The available reports include:
Top Browser Types
User Agent Operating Systems
Most Popular Pages
Most Popular Downloads
Errors Occurring Most Often
Page View Errors
Download Errors
Usage by Hits
Usage by Kilobytes
Usage by Session
Top Referring URLS
Top Referring Domains
Referring Advertising Domains
Referring Affiliate Domains
Top Referring Search Engines
Top Referring Search Engine Keywords
Top Referring Search Engine Keyword Phrases
Sessions by Machine
Sessions by Domain
Session by Country
Page/Files by Machine
Page/Files by Domain
Page/File Country Requests

To understand how Hi-Stats uses dates in its reporting, please see
Time and Date Reporting

Browser

The Browser Agent Analysis report lists the web browsers used to access your site based on 
the number of requests made by the browser type in the given time frame. It lists the 
Browser Type, number of hits and the percentages of hits as compared to the total number 
of hits. Results are ordered from most common to least common. 

You can use this information to help develop the content of your web.    If you want to use 
advanced features in web site, but determine that only 20 percent of all visitors will be able 
to support these features, then you may not want to spend the time to do this.    If you have 
many visitors with older browsers, you may want to make sure that your web site meets 



their needs as well.

User Agent Operating System

The User Agent Operating System Analysis Report lists the User Agent Operating Systems 
used to access your site ordered from most common to least common. 

This information can be valuable in determining the audience of your web site.    Knowing 
the audience, you can tailor your content or advertising to specific users.    If you had a 
large number of LINUX users on your site, you may offer content that specifically targets 
these users.

 Most Popular Pages

The Page View Analysis report lists the most popular pages on your site, based on the 
number of hits each has received in the given time frame. It lists the page name, number of 
hits and the percentages of hits as compared to the total number of hits. Results are 
ordered from most hits to least hits.
Knowing which pages have the most hits, you can determine where to place content, what 
page designs work best and what pages may be linked to from external sites.

Most Popular downloads

The File Download Analysis report lists the most popular downloads on your site, based on 
the number of times downloaded in the given time frame. It lists the download file name, 
number of downloads and the percentage of downloads as compared to the total. Results 
are ordered from most downloaded to least.

By determining which files are downloaded the most, you can further tailor your marketing 
strategy towards certain product lines and such.    If the number of downloads for files 
restricted to paying customers are increasing far above the number of sales, it could be a 
sign of software piracy.

 Errors occurring most often
The Errors Analysis Total report tabulates the total number of errors that occurred during 
the given time frame.    See your web server documentation for more information on these 
errors.
Some common errors are
· 400:    Bad Request:    The request could not be understood by the web server due to bad 

syntax.
· 401:    Unauthorized Request:    This error typically occurs when the web server will not 

allow that request to be completed due to security settings related to a user name and 
password.

· 403:    Access is forbidden:    The web server will not allow that HTTP request to be 
completed due to security settings.    For example, the web server may not allow access 
for a specific set of IP addresses.    If a user from one of those IP addresses accesses the 
web page, that error will appear.

· 404:    Object not found:    Typically, this error occurs when the requested web page could 



not be found on the server.
· 405:    Method not allowed:    This error may occur if a there is a configuration problem 

between the web browser client and the web server.
· 500:    Server Error:    This error typically occurs when the web server encounters an 

unexpected condition.
· 501:    Not Implemented:    The web server is not configured to handle that sort of HTTP 

request.

Page View Errors
The Page Errors Analysis report tabulates the number of errors that occurred when trying to 
view a page during the given time frame.    Each page is listed along with the error relating 
to that page, the number of occurrences and the percentage of total errors for that 
particular error.
This information can be used to determine which pages web guests are requesting that are 
not being displayed to them.    This could mean that the page has a problem or is missing 
altogether.

Download Errors
The Download Errors Analysis report tabulates the number of errors that occurred when 
trying to download a file during the given time frame. 
This information can be used to determine if web users are trying to download files that are 
missing from the web site.    It can also be used to alert you of web guests trying to 
download files they are not authorized to download such as web system files and such.

Usage by Hits
Usage by Hits reports the number of requests made in the given time frame. A Hit is 
considered any request for data such as a Web page, Image, or file.    For example, if you 
have a web page that had two images, ran one script and played one wave file, there would 
be five hits for that web page.    The report shows the hour, the number of hits for that hour 
and the percentage of hits for that hour.

Usage by Kilobytes
Usage by Kilobytes reports the number of kilobytes sent in the given time frame. The total 
movement of pages, images, files and CGI requests are counted.
This is important because it helps you keep track of the bandwidth used by the web server. 
Some Internet Service Providers determine moths fees based on bandwidth.    You may also 
wish to know the bandwidth so you may plan for scheduled service upgrades as bandwidth 
increases

Usage by Session
Usage by Sessions reports the number of sessions started by hour in the given time frame. 
Sessions are tracked per unique IP address.
With this information, you can track individual guests to your web site.    This can be used to 
determine the number of individual users to the web site over specified time periods.      The 
report outlines the number of sessions started per hour and their percentage of total 
sessions.



Referring URLS
The Referring URL report tabulates all URLs pointing to your site ordered by number of 
referrals they made.    The URLs are listed in order of number of referrals.    The table shows 
the actual number of referrals along with the number of referrals and their 

Top Referring Domain Report
The Referring Domain Report tabulates referrals made by domains pointing to your site.  
This is helpful in determining what site visitors are entering your site from.

Top Referring Advertising Domain Report
The Referring Advertising Domain Report tabulates the referrals from domains you have 
designated as Advertising Domains pointing to your site. Results are ordered by number of 
referrals they made.

Top Referring Affiliate Domain Report
 The Referring Affiliate Domain Report tabulates the referrals from domains you have 
designated as Affiliate Domains pointing to your site. Results are ordered by number of 
referrals they made.

Top Referring Search Engines
The Referring Search Engine Report tabulates Search Engine pointing to your site ordered 
by number of referrals they made.    At the bottom of the list is a percentage of total search 
engine referrals versus total referrals.

Top Referring Search Engine Keywords
The Referring Search Engine Keyword Report tabulates what keywords have been used on 
the popular search engines to locate the Web site, for the selected time period.    This is 
useful because you can determine which keywords are directing users to your site on the 
engines.

Top Referring Search Engine Keywords phrases
The Referring Search Engine Keyword Phrase Report tabulates what keyword phrases have 
been used on the popular search engines to locate the Web site, for the selected time 
period.    This is useful because you can determine which keywords are directing users to 
your site on the engines.

Sessions by Country
The Sessions by Country Report tabulates the number of unique sessions in the given time 
frame grouped by the country where the request originated.    This information is 
determined from the country code of the host name (if present).    This report requires that 
the web server log files contain IP addresses that are resolved to host names.    If the log 
file does not contain domain host names, then the results of those IP address not resolved 
will be listed as unavailable.    Please refer to your web server documentation for more 
information on resolving IP addresses to domain host names.

Sessions by Domain



The Sessions by Domain Report tabulates the number of unique sessions in the given time 
frame grouped by the domain where the request originated.    When tabulating, a prefix in 
front of the domain if found is ignored.    For example, the log entries of proxy2.aol.com and 
outbound6.hisoftware.com would be listed as aol.com and hisoftware.com respectively.    
This report requires that the web server log files contain IP addresses that are resolved to 
host names.    If the log file does not contain domain host names, then the results of those 
IP address not resolved will be listed as unavailable.    Please refer to your web server 
documentation for more information on resolving IP addresses to domain host names.

Sessions by Machine
The Sessions by Machine Name Report tabulates the number of unique sessions in the given 
time frame grouped by the machine name where they originated.    In this report, the 
program will list the client machines as they appear in the web server log, either by IP 
address, or by Domain Host Name.    In this report, host name prefixes, if they exist are 
counted as separate machines.    For example, if the web server log file included the 
computers outbound6.hisoftware.com and outbound7.hisoftware.com, those would be 
counted as two separate computers.

Pages/Files by Country requests
The Pages/Files by Country Report tabulates the number of page and file requests in the 
given time frame grouped by the country where the request originated.    This information is 
determined from the country code of the host name (if present).    This report requires that 
the web server log files contain IP addresses that are resolved to host names.    If the log 
file does not contain domain host names, then the results of those IP address not resolved 
will be listed as unavailable.    Please refer to your web server documentation for more 
information on resolving IP addresses to domain host names.

Pages/Files by Domain
The Pages/Files by Domain Report tabulates the number of page and file requests in the 
given time frame grouped by the domain where the request originated.    When tabulating, a 
prefix in front of the domain if found is ignored.    For example, the log entries of 
proxy2.aol.com and outbound6.hisoftware.com would be listed as aol.com and 
hisoftware.com respectively.    This report requires that the web server log files contain IP 
addresses that are resolved to host names.    If the log file does not contain domain host 
names, then the results of those IP address not resolved will be listed as unavailable.    
Please refer to your web server documentation for more information on resolving IP 
addresses to domain host names.

Pages/Files by Machine Name
The Pages/Files by Machine Name Report tabulates the number of page and file requests in 
the given time frame grouped by the machine name where they originated.    In this report, 
the program will list the client machines as they appear in the web server log, either by IP 
address, or by Domain Host Name.    In this report, host name prefixes, if they exist are 
counted as separate machines.    For example, if the web server log file included the 
computers outbound6.hisoftware.com and outbound7.hisoftware.com, those would be 
counted as two separate computers.



Web Manager

The Web Manager is used to import log files and create new web properties.    You may open 
the Web Manager by selecting Web Management from the File menu.    Note: This feature 
is not available in Hi-Stats Small Business Server Client.

Toolbar buttons:
· New:    Selecting the New button creates a new web and allows you to select log files 

and log file format type.
· Edit:    Selecting the Edit button allows you to edit the properties for the web.
· Delete:    Selecting the Delete button allows you to delete a web from the listing of 

webs.
· Import: Selecting the Import button imports log files for the selected web.
· Exit:    The Exit button closes the Web Manager
· Help:    Selecting the Help button opens the help files for this topic
· About:    The About box provides version information on the Web Manager.

Differences in the versions

Hi-Stats Basic supports up to 3 webs.
Hi-Stats Professional supports up to 50 webs.
Hi-Stats Enterprise supports unlimited webs.
Hi-Stats Small Business Server supports importing the logs to a shared directory for 

use by Client versions.
Hi-Stats Small Business Server Client cannot import webs, but can create reports 

from imported webs created by the Server edition.

Using the Web Manager
From the File menu, select New. You may alternatively right click with the mouse and 
select New from the pop-up menu.

In the Web Property Editor, enter a name for the web.    Make sure the name is eight 
characters or less.

For the Log file import type, select the option to import log files located locally, or 
ones located on an FTP site.

For log files located locally on your system, select the local option and then the file path 
to the directory where these logs are located.    Use the File Chooser button to the right 
of the File Path field to browse to the correct folder.    All log files for one web project 
need to be in the same directory.    You can also manually type in a path to your log files 
and user Wildcards. For example, to get all files in a particular directory, you might enter 
C:\winnt\system32\logfiles\w3svc1\*.log

Rules for Local File Imports and Wildcards:

Multiple files must be separated by commas.    i.e. C:\logs\log1.log, C:\logs\log2.log
Each file can optionally be surrounded by double quotes i.e. "C:\logs\log1.log", "C:

\logs\log2.log"
Only file names can contain wildcard characters.    File Paths cannot contain 

wildcards.    i.e. C:\logs\*.log      Not C:\*.*\*.logs
If wildcard found then multiple files are not allowed.    You must have something like 



C:\log\*.log, not c:\logs\*.log,k:\logs\ex1000.log
Each file path must exist.    You cannot have a file path that does not really exist on 

your system or networked drives.

If you wish to select the Get New Files Only checkbox, you must use a file mask such 
as *.log. 
Using the Get New Files Only checkbox is great for when you only want to import the 
latest log files in a directory.    This is specfically designed for users who install Hi-Stats 
on the same computer that runs their web server.

In the Server URL field, enter the URL of the server, for example, www.hisoftware.com.

When complete, select the Save button.    To cancel without saving, select the Cancel 
button.

If your log files are accessible by FTP, then select the FTP option.    An FTP Settings tab 
appears in the Web Property Editor

In the FTP Server Address field, enter the server address.    This field will be similar to 
ftp.hisoftware.com or www.myISP.com.    You may also use the Internet IP address for 
this FTP site, by entering the IP such as 10.14.11.234 substituting your IP address for 
the example one given.

If you need to access a proxy server to access the Internet, enter the IP address of the 
proxy server followed by the Port that the proxy server runs on.      For example, 
172.16.0.2:80 where 172.16.0.2 is the IP address and 80 is the port.    Most users will 
not need to enter a proxy setting.    Users with home networks where only one computer 
has a direct connection to the Internet in some cases may need to enter a proxy setting.

Enter the User Name and Password for the FTP site.    For some ISPs, this is normally 
the same user name and password required for your dialup connection.    If you are not 
sure of your user name and password, contact your ISP or whomever is the 
administrator of the FTP site.

Hi-Stats then needs the directory on the server where your log files are stored.    This 
information is also derived from your ISP or administrator for the FTP site.      For 
example if the directory on the ftp.hisoftware.com site was users/my_user_name/logs, 
you would enter /users/my_user_name/logs/ in the Directory on Server field.    If 
the files are found in the root of the FTP server, you would enter / as the path.

The File Pattern Mask allows you to select files of certain types such as log file, txt files 
etc.    This mask uses standard windows wildcards.    For example, if you have 3 log files 
named ex000201.log, ex000202.log, and ex000203.log, you would enter either ex*.log 
or *.log as the mask.    Entering those masks in the example would allow the server to 
download all files starting with ex and ending with .log and for the second example, all 
files ending in .log.

If you only want the program to look for new files on the server and to avoid the ones it 
has already downloaded. Select the Get new files only checkbox.

When done, select the Save button.

Back in the Web Manager, select the Hi-Stats web you just created and then select the 
Import button.    The log files will then be imported into the program for use by Hi-
Stats. 

At the next window that appears, select the Create Session Tracker Database 
checkbox to create a database used by the Session Tracker feature of the program.



Next, select the Import Now button to proceed with the import.

If you are satisfied with the web you just created, you can select the Exit button.    If you 
are not satisfied, you can select a web and then edit it by selecting the Edit button, or 
delete it by selecting the Delete button.

The topic below applies only for users of Hi-Stats Small Business Server edition.

Set Log Import Data Directory

Hi-Stats Small Business Server allows you to place your imported webs on a shared 
drive where client users of Hi-Stats Small Business Server can access the processed log 
file data.    This requires that the Server version write to the imported logs to a shared 
directory and that the Client users have write access to a mapped network drive 
containing the shared imported and processed log file data.    For more information on 
mapping network driveand sharing directories, please refer to your Windows operating 
system documentation.

1. To change the Import Data Directory from its default value to a shared location, 
select the Set Log Import Data Directory option from the Edit menu of the Web 
Management window.

2. Choose the Directory File Chooser button and select a shared drive (and directory) 
that users of the Client version will have access to.

3. When done, select the OK button.



Session Tracker

The Session Tracker is used to track the path visitors have taken through your web.

Using the Session Tracker
1. To open the Session Tracker, select Session Tracker from the File menu of Hi-Stats.
2. In the web menu, select a web from the list.    Any web you select from the list must 

have first been imported into the program.    (See topic help for web management)
3. In the top left corner of the Session Tracker window, select the web from the listing of 

webs.
4. Select a year and a date to analyze and then select the lightning bolt button.    The 

Session Tracker will read the log files and only allow certain dates contained within the 
log files to be selected by the user.    For example, if your log files were only for the 
month of March 2000, the program would not allow you to select the month of July. 

5. Select the Refresh button (shaped like a lightning bolt) to begin the session tracking 
analysis

6. To perform a name server lookup on an IP Address, select the Lookup Client Host IP 
Name button.    If the IP Address can be resolved to a host name, the name will be 
presented in a window that appears.    Note:    Not all IP addresses can be resolved to 
names.

Understanding the session tracking
Once the session tracking analysis has been completed, there will be data on both sides of 
the window.
The left side of window is a tree with the host names of the visitors to your web site.    Those 
host names that could not be resolved in the Domain Name Server (DNS) lookup will be 
listed by their IP address.    The hosts are listed alphabetically with the numeric values 
appearing before the alphabetical hosts. 
Expanding on the + sign under the host name gives the IP address for that host.

The right side view of the view contains headings for Time, Client IP Address, File or Page 
Visited and Referring URL.      All hits for pages and images are shown in this view

Time:    Time refers to the time the hit was registered in the log file.
Client IP Address:    Client IP address refers to the Internet Protocol (IP) address of 

the web guest that made the hit on the server.
File or Page visited:  This listing shows the page or file accessed in the session.
Referring URL: The Referring URL shows the URL that the web guest was at before 

coming to your page.



Getting Started

How it Works
Hi-Stats is a program from HiSoftware that performs analysis of the Internet web servers 
access log files.    Log files from web servers can contain tens to hundreds of thousands of 
lines of information.    Hi-Stats takes these log files and performs the analysis using simple 
to read graphs and reports.    Hi-Stats does not record or log access to the server, rather it 
takes the server access logs and makes them far easier to understand.

Getting Started
Getting Started with Hi-Stats is easy.    First, you need access to the log files from your web 
server.    These log files can be in an any of the following formats: IIS 3.0, W3C, W3C 
Extended, NCSA STANDARD, NCSA Extended and CERN.    Hi-Stats automatically detects the 
log file format, but you need to make sure that the logs meet the listed formats above.    If 
you have your own web server, you can set the log files in the web server program.    If 
another party administers the web server, you need to contact them to verify the correct log 
file format and receive copies of the log files.

Information needed from the web server administering party.    If you do not administer your 
web server, you need to contact your web server administrator (usually an Internet Service 
Provider) and explain that you are running a web site log analysis program.    You need 
copies of the log files and need the log files to be in one of the formats listed above, 
preferably the W3C Extended with as many options selected in the log as possible.    The log 
files should preferably be in a daily format, though weekly and monthly will also work.

Information needed in the log files
The log files for the web sites need to contain the following information for basic 
functionality:

Date (either in a header or in the record)    The date format must include four digits 
for the year.    For example, the year 2000 must be represented as 2000, not 00.    In 
Windows based systems, you can change the date format in the Regional Settings icon in 
Windows Control Panel.    Note:    This date format must be set on the computer generating 
the log server files.    In you are using a UNIX or LINUX based web server, please see the 
operating system and web server documentation for more information on changing the date 
format to 4 digit year format.

Time 
Client - IP address 
Method (GET,POST, PUT, etc...) 
File accessed 

For optimal reporting, the following information is required
Server IP address:      This is the IP address of the web server.
Bytes Transferred:      This is the amount of data transferred per hit on the server.    

This is used to complete information in the Average Data Transferred and usage by kilobytes 
reports.    If this information is not in the log, Hi-Stats cannot report it.

Status Code:    This is used to report on whether the request on the web server was 
fulfilled successfully or whether there was an error.    If there was an error, then web server 
will log the specific error code in the log.    If this information is not in the log, Hi-Stats 



cannot report it.
Referring URL:      This is used to report what web site the web guest was at previous 

to visiting your site.    This information is used in several reports in the referral analysis 
reports.    If this information is not in the log, Hi-Stats cannot report it.

User Agent: The user agent is used to identify the browser types and operating 
systems of the guests to the web site.    If this information is not in the log, Hi-Stats cannot 
report it.

Some web servers do not include all the information by default in their default log format.    
For some web servers on the UNIX platform, additional modules must be added to the web 
server and then the web server program must be compiled.      For other servers such as 
Microsoft Internet Information Server, the log format can be selected from a menu with 
some log formats offering choices for additional information.    The more information in the 
log format, the more results can be shown by Hi-Stats.    Many Internet Service Providers 
already created their server logs in a format that makes them favorable to web site analysis 
programs such as Hi-Stats. 

Creating a Hi-Stats web
Once you have determined where your log files are, you need to create a new Hi-Stats web. 
For the purposes of the Hi-Stats program, a web is a collection of log files for a specific web 
site.    You can have multiple Hi-Stats webs for any one Internet web site.    Once you have 
selected the log files for a Hi-Stats web, you select the Import button in the web 
management window to import them for use in the program.    For more information on 
setting up a web, see the help topic for web management.      Once you have created a Hi-
Stats web, you need to then create a report profile for the web.

Creating a Report Profile
From the main window of Hi-Stats, select the New button and complete the various tabs for 
creating a report profile. Within these tabs, you select the report name, the Hi-Stats web, 
the style of report along with other information for the report.    Please see the Profile Editor 
help for more information.

Running the Report
Once you have completed the report profile, you can run the report by double clicking on it 
and then selecting the   Run Report   button  .    The report will run and the results will appear 
in the default web browser.      For more information on the understanding the results, please 
see the help topic for understanding the results. 

The main screen of Hi-Stats has three sections:    A menu, a toolbar and a viewer window.    
Both the menu and the toolbar contain commands and options to run the program.    The 
viewer window contains a listing of profile reports that you use to run the analysis reports.

Working with reports
From the File menu and the toolbar, you have the option to:

Create a new report:    Select New from the toolbar or select New Report Profile 



from the File menu to create a new report.
Open an existing report:    Select Open from the toolbar or select Open Existing 

Report Profile from the File menu to open an existing report.
Delete an existing report:    Select Delete from the toolbar or select Delete 

Selected Report Profile from the File menu to delete a report.
Run a report:    Select Run from the toolbar or select Run Selected Report     Profile   

from the File menu to run the analysis on an existing report.

Working with views
Hi-Stats™ gives you the option to change the way the reports appear in the viewer window.
From the View menu, select Large Icons, Small Icons or List.    You may also select the 
Views button on the toolbar to cycle through the views and the downward pointing arrow to 
the immediate right of the Views button on the toolbar to open a menu with the same 
options listed above.



Time and Date Reporting

Many reports in Hi-Stats refer to a time and date that an event occurred.    The time and 
date used by Hi-Stats is extracted from the web server log files.    Many web server log files 
use Greenwich Mean Time (GMT) to log events into the web server logs and use Greenwich 
Mean Time to roll over to another log at the end of specified reporting period.      Other web 
servers may log at Greenwich Mean Time, but roll over at the select time zone of the 
operating system where the web server is installed.    For more assistance in determining 
how your web server tracks the time and date, please refer to your web server 
documentation or the administrator of your web server.



Web Property Editor

Using the Web Property Editor

1. In the Web Property Editor, enter a name for the web.    Make sure the name is eight 
characters or less.

2. For the Log file import type, select the option to import log files located locally, or 
ones located on an FTP site.

3. For log files located locally on your system, select the local option and then the file path 
to the directory where these logs are located.    Use the File Chooser button to the right 
of the File Path field to browse to the correct folder.    All log files for one web project 
need to be in the same directory.    You can also manually type in a path to your log files 
and user Wildcards. For example, to get all files in a particular directory, you might enter 
C:\winnt\system32\logfiles\w3svc1\*.log.    See Rules for Wildcards and Local File 
Import.

4. In the Server URL field, enter the URL of the server, for example, www.hisoftware.com.

5. When complete, select the Save button.    To cancel without saving, select the Cancel 
button.

6. If your log files are accessible by FTP, then select the FTP option.    An FTP Settings tab 
appears in the Web Property Editor

7. In the FTP Server Address field, enter the server address.    This field will be similar to 
ftp.hisoftware.com or www.myISP.com.    You may also use the Internet IP address for 
this FTP site, by entering the IP such as 10.14.11.234 substituting your IP address for 
the example one given.

8. If you need to access a proxy server to access the Internet, enter the IP address of the 
proxy server followed by the Port that the proxy server runs on.      For example, 
172.16.0.2:80 where 172.16.0.2 is the IP address and 80 is the port.    Most users will 
not need to enter a proxy setting.    Users with home networks where only one computer 
has a direct connection to the Internet in some cases may need to enter a proxy setting.

9. Enter the User Name and Password for the FTP site.    For some ISPs, this is normally 
the same user name and password required for your dialup connection.    If you are not 
sure of your user name and password, contact your ISP or whomever is the 
administrator of the FTP site.

10.Hi-Stats then needs the directory on the server where your log files are stored.    This 
information is also derived from your ISP or administrator for the FTP site.      For 
example if the directory on the ftp.hisoftware.com site was users/my_user_name/logs, 
you would enter /users/my_user_name/logs/ in the Directory on Server field.    If 
the files are found in the root of the FTP server, you would enter / as the path.

11.The File Pattern Mask allows you to select files of certain types such as log file, txt files 
etc.    This mask uses standard Windows wildcards.    For example, if you have 3 log files 
named ex000201.log, ex000202.log, and ex000203.log, you would enter either ex*.log 
or *.log as the mask.    Entering those masks in the example would allow the server to 
download all files starting with ex and ending with .log and for the second example, all 
files ending in .log.

12. If you only want the program to look for new files on the server and to avoid the ones it 
has already downloaded. Select the Get new files only checkbox.

13.When done, select the Save button.



Features of Hi-Stats is only available in Hi-Stats Small Business Server

Users of Hi-Stats Small Business Server will see an additional checkbox to Delete Files 
from FTP Server.    This option can be used to delete log files from the server after they 
have been downloaded and imported into Hi-Stats.    Select this option if you want to delete 
the log files from the server after Hi-Stats has imported them.



Running the Reports

If you selected log files located locally on your system, then running a report is as simple as 
selecting a log in the main screen of Hi-Stats and double clicking on it.    As long as the 
dates selected in your report profile match those in your logs, the reports will run.

If in the Web Manager, you selected FTP instead of Local for the location on your log files, 
then there are a few more choices available to you while running the report.    If you run a 
report and have dates selected in your report profile that you do not have available in the 
cached logs on your system, the program will prompt you to download and import them at 
that time. 

Selecting No to the Import
If you select No, the program will run the reports without the missing data if possible, 
assuming it can find the log data for some of the time period.    For example, if the month is 
May and you select a time period of Year to Date, but are missing log files for January and 
March, the report will still run for the year, but with data missing from January and March.    
If you select a to run a report for last week, but have none of that data, then the report will 
not run because it does not have any log file data to use. 

Selecting Yes to the Import
If you select Yes, the program will use your FTP settings to download the latest files from 
the server.    If the program did find new files on the server, it will download them.    After 
downloading the FTP reports, if the program prompts to import the files again, select No to 
proceed to the creation of the reports.    If you select Yes, the process of downloading will 
repeat again.



Page/Files by Machine
The Page/File by Machine Name Report tabulates the number of page and file requests in 
the given time frame grouped by the machine name where they originated.    In this report, 
the program will list the client machines as they appear in the web server log, either by IP 
address, or by Domain Host Name.    In this report, host name prefixes, if they exist are 
counted as separate machines.    For example, if the web server log file included the 
computers outbound6.hisoftware.com and outbound7.hisoftware.com, those would be 
counted as two separate computers.



Page/Files by Domain

The Page/File by Domain Report tabulates the number of page and file requests in the given 
time frame grouped by the domain where the request originated.    When tabulating, a prefix 
in front of the domain if found is ignored.    For example, the log entries of proxy2.aol.com 
and outbound6.hisoftware.com would be listed as aol.com and hisoftware.com respectively. 
This report requires that the web server log files contain IP addresses that are resolved to 
host names.    If the log file does not contain domain host names, then the results of those 
IP address not resolved will be listed as unavailable.    Please refer to your web server 
documentation for more information on resolving IP addresses to domain host names.



Page/File Country Requests

The Page/File by Country Report tabulates the number of page and file requests in the given 
time frame grouped by the country where the request originated.    This information is 
determined from the country code of the host name (if present).    This report requires that 
the web server log files contain IP addresses that are resolved to host names.    If the log 
file does not contain domain host names, then the results of those IP address not resolved 
will be listed as unavailable.    Please refer to your web server documentation for more 
information on resolving IP addresses to domain host names.



Sessions by Country

The Sessions by Country Report tabulates the number of unique sessions in the given time 
frame grouped by the country where the request originated.    This information is 
determined from the country code of the host name (if present).    This report requires that 
the web server log files contain IP addresses that are resolved to host names.    If the log 
file does not contain domain host names, then the results of those IP address not resolved 
will be listed as unavailable.    Please refer to your web server documentation for more 
information on resolving IP addresses to domain host names.



Sessions by Domain

The Sessions by Domain Report tabulates the number of unique sessions in the given time 
frame grouped by the domain where the request originated.    When tabulating, a prefix in 
front of the domain if found is ignored.    For example, the log entries of proxy2.aol.com and 
outbound6.hisoftware.com would be listed as aol.com and hisoftware.com respectively.    
This report requires that the web server log files contain IP addresses that are resolved to 
host names.    If the log file does not contain domain host names, then the results of those 
IP address not resolved will be listed as unavailable.    Please refer to your web server 
documentation for more information on resolving IP addresses to domain host names.



Sessions by Machine

The Sessions by Machine Name Report tabulates the number of unique sessions in the given 
time frame grouped by the machine name where they originated.    In this report, the 
program will list the client machines as they appear in the web server log, either by IP 
address, or by Domain Host Name.    In this report, host name prefixes, if they exist are 
counted as separate machines.    For example, if the web server log file included the 
computers outbound6.hisoftware.com and outbound7.hisoftware.com, those would be 
counted as two separate computers.



Select Log Data Directory

This feature is available only with Hi-Stats Small Business Server Client.

Before starting, talk with the Hi-Stats administrator in your organization about where the 
imported log files for Hi-Stats will be stored.    You will need Change access to this share 
and you need to map a network drive to this share.    Please refer to your windows 
documentation regarding shared directories and mapping network drives.

Accessing the Select Log Data Directory window:    From the Settings menu and select 
Set Log Data Directory.

Choose the Directory Chooser button (with the folder tree view icon) to the right of the 
Directory field opens a folder tree view.    In this window, you can select the folder in which 
you store your log data.    This location has to be the same location as selected by the Hi-
Stats Server component plus the wwwstats subdirectory.    For example, if the server 
component stores the imported log files on a shared directory called X:\Public\LogFiles, 
the Clients need to select the X:\Public\LogFiles\wwwstats directory.      The path to the 
folder you choose will appear in the Directory field of the Select Log Data Directory 
window after you select OK.    Selecting Cancel will cancel the changes and return the 
Directory to the original value.

Warning: Changing the data directory will make all previously imported data unavailable and 
may cause errors in previously created profiles.



Select Log Import Directory
This feature is available only with Hi-Stats Small Business Server.    It designed to be used in 
conjunction with the Hi-Stats Small Business Server Client.

Before starting, the Hi-Stats administrator in your organization needs to create a network 
share where the imported log files will be placed.    It can be local to the server or created 
on a separate file server. Authorized users of Hi-Stats Small Business Server Client then 
need CHANGE access to that share.    Please refer to your windows documentation regarding 
shared directories and mapping network drives.

Once the share has been created, the log files from the server need to be imported and 
placed onto the shared location

Instructions for importing and placing the logs on separate share:
1. From the Edit menu of the Web Management window, select Set Log Import 

Directory.
2. Choose the Directory Chooser button (with the folder tree view icon) to the right of 

the Directory field brings you to a folder tree view.    In this window, you can select 
the folder in which you store your log data.    The path to the folder you choose will 
appear in the Directory field of the Select Log Import Directory window after you 
select OK.    Selecting Cancel will cancel the changes and return the Directory to the 
original value.

3. Users of the Client version will then need to point to the same share from their 
systems by setting their Data Directory to read the processed log files.

Warning: Changing the data directory will make all previously imported data unavailable and 
may cause errors in previously created profiles.



Scheduler

The Scheduler feature of Hi-Stats is only available in Hi-Stats Small Business Server.

The Scheduler allows the Server computer to import log files from an FTP site or a local 
directory at specified intervals.    This feature requires that the Server computer have a 
persistent connection to the Internet, if the log files are imported from an FTP site, or a 
persistent connection to a shared or local drive, if the log files are imported locally.

The scheduler component will only look in one location for the location of the imported 
webs.    For example, if you originally had 2 webs imported locally to the C:\Program 
Files\Hi-Stats directory, but then you changed the Import Profile to a shared network drive 
and now have 10 webs at that new location, the program will only import from the listing of 
webs at the new location,

Using the Scheduler:
1. A list of available webs appears in the left side, and the webs selected for scheduling 

appear on the right. 
2. To add an available web to the schedule, select the web and then select Schedule Web 

from the Actions menu.    To remove a web from the schedule, select the web and then 
select Remove Web from schedule from the Actions menu.

3. In the Interval menu, select the time interval that you would like the webs to be 
imported.    Options range from 5 minutes to weekly.

4. When done, select the Save Autorun List button and then close the Scheduler window.
5. Next, select Run Now from the Autorun menu.    The program will minimize to an icon 

in the systray and will run on schedule.    Note:    The systray is located in the lower right 
corner of the Windows Desktop and usually contains the system time along with an icon 
of a speaker that is used to control the system sound volume.

6. To quit Autorun and restore the program in full view on the screen, right click on the Hi-
Stats icon in the systray and select Quit Autorun from the pop-up menu that appears. 

7. To show the main interface of the program when Autorun is running, right click on the 
Hi-Stats icon in the systray and select Show Console.

8. To view a log of the scheduler, select View Log from the Autorun menu.    A log appears 
showing imports of the log files for the selected webs.

Importing Schedule
The next import will start when the last import completed plus the interval time period.    For 
example, it is 1:00 PM and you schedule your imports at an Interval of 5 minutes.    If it 
takes 2 minutes to import your log file, the next import will be scheduled at 1:07 PM.
For the daily imports, they start at 12:01 AM and the weekly imports start at 12:01 AM on 
Sundays.

Persistent Internet Connection Required
If you import logs located on an FTP server, you need to have a persistent Internet 
connection in order for the import to work

Check before Scheduling
Before using the scheduler, it is important that you test the import to the selected webs in 
the Web Manager.    This will confirm that you have selected the correct path and if using the 



FTP version, that you have the correct user name and password.



Hi-Stats Small Business Server
Hi-Stats Small Business Server contains two components: a Server component and a Client 
component.    The Client component contains all the features of Hi-Stats necessary to create 
reports based on imported Hi-Stats webs.    In addition to containing all the features of the 
Client, the Server component is used to create and import the Hi-Stats webs, placing the 
imported data into an easily read format for the Client.    Since the majority of computing 
effort in Hi-Stats is performed importing and organizing the log files into a format used by 
Hi-Stats, it makes sense to have the Server component do it.    Then, Client components can 
read the processed log file data from the imported webs via a network share and quickly 
generate reports based on the processed log file data. 

This method of collaboration is advantageous for several reasons:

The raw web server log files only have to be collected, imported and processed by 
the one Server computer.    Depending on your log file size, the number of webs and the 
speed of your computer, the import can be take some time.    By only requiring one 
computer to do it, this method saves time and network resources.

Hi-Stats Small Business Server allows for scheduling of log file imports on the Server. 
The Server can be set to import at scheduled intervals and all Clients can have access to the 
latest log files by connecting to the Server.

Client components allow individual users to take processed log file data and create 
custom reports based on the information they need when they need it.    If several 
departments are analyzing the web site, each with its own purpose, it makes sense for a 
user in each department to have a Client license where individual reports can be created at 
will.

With the Client / Server setup, the company saves the cost of providing everyone a 
copy of Hi-Stats Enterprise, while still providing full reporting technology for those number 
of Client licenses purchased.




